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 INTRODUCTION 
 
Publisher is becoming the choice of  people who regularly produce high quality color              
publications such as newsletter, flyers, logos, signs, forms, brochures, and web pages. 
 
Unlike Microsoft Word Publisher allows users to lay out their works in layers.  It also allows 
you to create works on your own or use the assistance of  the Wizard. 
 
One of  the advantages of  Publisher is that it offers more control over certain aspects of  your 
publication. For instance, Publisher offers a work environment that makes it easy to work with 
documents in a variety of  sizes and shapes. It also has a larger variety of  tools to help you       
arrange and align text, images, and other objects within the page margins.  
 
One key difference in Publisher from Word you must use your toolbar objects  to insert text, 
clipart, WordArt, shapes, and zoom in on your text.  Documents  created in Word can be   
imported into Publisher. 
 
When user begin to enter data onto the workspace everything must be contained within the   
dotted blue lines.  That is the defined work area. 
 
Backstage view 
In Publisher 2010, options for saving, printing, and creating publications are located 
in Backstage view. It is similar to the Office Button Menu from Publisher 2007 or the File 
Menu from earlier versions of  Publisher. However, unlike those menus, it is a full-page view, 
which makes it easier to work with.  To access Backstage view, click the File tab. 
 

Working with text boxes 
In Publisher, text is contained in text boxes, which are blocks of  text that you can place on the 

page. The cursor will turn into crosshairs . Click anywhere on your publication and 
drag your mouse to create the text box.  
 

Wrapping text 
If  you place a text box near an image or another object, you may notice that the text is overlap-
ping with the object or doesn't appear exactly where you want. To fix this problem, you'll need to 
change the object's text wrapping settings. 
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To wrap text around an object: 
1. Select the object, then click the Format tab that appears on the Ribbon. 

Locate the Arrange group, then click the Wrap Text drop-down command. 
 
2. Select the desired wrap option. The text will adjust based on the option you have selected. 
 
 
 
 
 
 
 
 
3. If  necessary, reposition the object until the text wraps correctly.  If  you can’t get your text to 
wrap the way you wish, click the Wrap Text command and select More Layout Options from 
the menu. You can make more precise changes in the Advanced Layout dialog box that appears.  
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 As you work with text boxes, you might find that a text box isn't large enough to contain all of  
the text you want to include. When you run out of  room for text, you can use 
the  Link command to connect text boxes. Once two or more text boxes are connected, text 
will overflow or continue from one text box to the next.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To connect to a new text box: 
1. Select your text box. 
2. Click the Text Box Tools Format tab, then locate the Linking group. 
3. Click the Create Link command. 
4. The Link icon will appear in place of  your cursor. Click the spot on your publication where 
you would like to add the linked text box.  
5. The text box will be added. Resize it as necessary.   
6. Continue typing your text. Any text that overflows from the original text box will now appear 
in the connected box.  
 

Modifying text boxes 
The Text Fit options allow you to format text boxes that automatically adjust font or text box 
size to get a good fit. There are four text fit options you can apply to any text box: 

 Best Fit, which makes the text larger or smaller to fit the text box 

 Shrink Text on Overflow, which automatically shrinks the font size when the text box has 

no room for additional text 
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  Grow Text Box to Fit, which automatically enlarges the text box based on text size and 

length 

 Do not Autofit, which makes no automatic changes to the text or text box size; this is the 

default option 

 For instance, if  your text box was too small for your text you might apply Shrink Text on 

Overflow or Grow Text Box to Fit. 

 

 

 

 

 

 

 

 

 

 

 

On the other hand, if  you have a certain amount of  space for your text box and want your 

text to fill the entire area, you might select Best Fit. 

 

 

 

 

 To modify text fit, select the text box, then click the Text Fit drop-down command in 

the Text group of  the Text Box Tools tab. Select the desired option. 

 
Hyphenation 
Publisher automatically hyphenates words at the ends of  lines in order to improve text fit. You 

can control if  and how your words are hyphenated by modifying your hyphenation settings. 
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 To modify hyphenation settings: 
Select a text box, then click the Text Box Tools Format tab on the Ribbon and locate 
the Text group. 
Click the Hyphenation command. 

 
 
 
 
 
 
 
 

The Hyphenation dialog box will appear. Modify your hyphenation settings as desired. 

 To remove all hyphenation, uncheck the Automatically hyphenate this story box. 

 

 

 

 

 
To change how frequently Publisher hyphenates words, use the up and down arrows to adjust 
the size of  the hyphenation zone. If  you increase the size of  the hyphenation zone, your  
publication will have fewer hyphens. If  you decrease it, the right edge of  the text will appear 
more even, but your text will contain more hyphens. 
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 To specify exactly where each word should be hyphenated, 
click Manual... The Hyphenate dialog box will appear, containing one hyphenated word from 
your text box. To change where the hyphen appears in that word, simply click the place where 
you want the hyphen to appear, then click Yes.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click OK. The hyphenation will be adjusted  
 

There are six Publisher typography commands: 

1. Drop Cap, which enlarges the first letter of  the selected text 
2. Number Style, which lets you choose between four different styles for number spacing and 
alignment  
3. Ligatures, which connect certain combinations of  letters to make them easier to read  
4. Stylistic Sets, which let you choose between various embellishments for your fonts, usually 
in the form of  exaggerated serifs or flourishes  
5. Swash, which embellishes capital letters  
6. Stylistic Alternates, which offer alternate versions of  specific letters such as g  

 
Objects can be grouped together as one in Publisher 
At times, you may want to group multiple objects into one object so they will stay together if  
they're moved. This can be easier than selecting all of  the objects each time you want to move 
them. 
To group objects: 
Select the objects you wish to group. 
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 Click the Format tab, then locate the Arrange group. 
Click the Group command.  The selected objects will now be grouped. There will be a single 
box with sizing handles around the entire group to show that they're one object.  
 
New pages are added to your document by clicking on Insert Page and indicate the number of  
page(s) to be inserted.  Within Publisher pages can be easily added, deleted and rearranged.  
Simply highlight the page and click and move or delete. 
 
If  you're planning on printing your publication yourself, your planning doesn't stop when you 
finish your layout. Before you print your publication, you'll have to make certain decisions 
about how you want to produce and distribute it.   Depending on the type of  publication you're       
creating, you might want to consider using something other than standard white paper. For     
instance, people usually print greeting cards on a heavier type of  paper called card stock . 
 
You have three color options for your printed publication: 

 Color 

 Grayscale, which prints images and details in shades of  gray 

 Black and white, which prints all images and text in black ink without any shading; many    
photocopiers only produce black-and-white images. 

 
Publisher offers a variety of  print settings you can modify to suit your needs. Among these are 
two tools for advanced printing tasks: double-sided printing and collating. 
 Double-sided printing 
    Double-sided printing allows you to print on both the front and back of  each sheet of  paper.      
Publisher gives you two choices for double-sided printing: You can flip, or turn, the page on 
the long side of  the page or the shortside. 
 
 Collating 

The collated printing option lets you assemble copies of  your publication with all pages in 
the correct order. By automatically grouping individual copies of  your publica-
tion, collating can save you a lot of  time and effort.  

 
Before printing Preview your work.  You can do this by clicking on File-Preview, or  using the 
shortcut tool (which is the white paper with the magnifying glass on it).   
 
We will explore some of  the unique features that Publisher has to offer. The first choice that 
needs to be made regarding any publication is the Page Layout.  Creating a publication from a 
template takes care of  most of  these choices for you.  However, if  you create a publication from 
scratch or decide to modify the template, there are three components of  page layout that need 
to be considered: size, orientation, and the margins.  As we work with samples you will       
develop a better understanding of  this concept. 
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 Let’s look at some of  the customized templates that’s within Publisher.  User have the option of  
working with a preset design or creating their own blank document.  We will be exploring how to 
create a certificate and a program from a template, designing a flyer and greeting card 
from scratch. 
 
Let’s Get Started: 
ALL TEXT USED IN PUBLISHER IS INSERTED USING THE TEXTBOX  
 
1. Click Awards Certificate and click Appreciation #7 and click OK. 
2. We are going to change the color to Orange instead of  Burgundy.  Handles will appear, 

right mouse click on the certificate and click Format Auto Shape. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. In the Fill section under Color: Click on the drop down arrow and select the color orange.    
Line Color will also be Orange and click OK.  Change all the colors that are currently  
burgundy to orange. 
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 4. Change the font to Goudy Stout and adjust the textboxes to accommodate the font.  Title 
Size 24, remaining textboxes size 16 and the name size 22.  
5. Click on the Square and draw it completely around the certificate. Click on line thick-
ness and click on the second 6pt size. 
6. Change the lines to black, and do a no fill for the background.  See example below 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Certificate backgrounds can be removed and modified at any time.  Save your work first 
as a document and secondly as a template to be used later or modifications added. 
 

DESIGNING A PROGRAM USING A TEMPLATE 
 
Open a new blank Publisher Publication, click Program and click Musical. Notice there 
are four pages to this program. Begin on page 1. 
 
1.  Highlight Business Name and type in your school name.  Highlight Program title and type 
in Spring Musical.  In the date and time section make the font larger and type in the actual 
date and time of  the program. 
2. Click on the second page.  (Notice pages 2-3 appear) One of  two things can happen, one all 
of  the textboxes can be eliminated and set up to accommodate your actual program or the text-
boxes can be modified to include some of  the materials for an actual program.  Or the program 
can be left blank and we’ll save it as a template to fill in the blanks later). 
3. On the 4th page the contents can be left as is, textboxes deleted if  not needed or completely 
deleted and inserted with your own information. 
4. Go to File-Save As—name the document and the type will be a Publisher Template.  
This document can be re-opened and used later with information obtained to complete the  
program. 
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 Creating a Flyer From Scratch 
 

1. Open Publisher and click on Blank Publication.  Adjust your margins under Page Setup.    
L-R 0.5; T-B 0.6. 
2. On the menu heading click Insert scroll down to Design Gallery Object.  Scroll and view all 
of  the various design headings as well as the various categories you can insert. 
3, Click on Attention Getters, scroll down to Corner Starburst Attention Getter and click      
Insert Object. 
4. Move the attention getter to the left corner of  your screen.  Do not ungroup this object. 
 
 
 
 
 
 
 
 
 
5. Resize the object as shown in the illustration  
6. Click two times on the attention getter object, click on the paint can and select an orange 
color. 
7. Click on the text icon until you see the dots. Highlight the word and type in JPS make the 
color orange and the square black by clicking on the paint can. and click black. 
 
 
 
 
 
 
8. Go back to Insert and click on Design Gallery Object; and scroll back to  
Attention Getter Object.  Scroll down to Bar and Lines Attention Getter and click Insert 
Object. 

9. Resize Bar and Lines Attention Getter and move up by Attention Getter as shown in the 

illustration. 
 
 

JPS 

00% Off JPS 
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 10. Click two times on the Bar and Lines Attention Getter and click on the paintbrush and 
select the black color.  Click on the Lines shortcut and click 3pt. 
 
 
 
 
 
 
 
 
11. Repeat the same process as above for the bottom set of  lines. 
12. Highlight the text and type in the information given. Select the font of  Garamond, Size 14 
and the color black.  
 
OPEN A NEW WINDOW IN PUBLISHER AND USE A BLANK PAGE.  THIS SAME 
PROCESS WORKS IN POWERPOINT AS WELL. 
 
1. Go to your home page http://www.jpsk12.org/Home/tabid/232/Default.aspx and 

you are going to copy the top half  of  your webpage.  Click print screen on your keyboard.  
Keep the website open. 

2. Click Edit Paste or Ctrl V.  The top part of  your page should be visible.  Click on the 
Crop Tool on your toolbar. Crop the picture similar to the image shown. 

 
 
 
 
 
 
3. Right mouse click on the picture to obtain the dialog box as shown below. 

Jackson Public Schools 
5444 Wildwood Avenue 
Jackson, Michigan 49201 

Tele: 517-841-2200 
JPS 

Click on Save as Picture 
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4. Another dialog box will appear prompting  you to save the picture, name it, change the 
format from a png to a jpeg.  Click JPEG name the file logo and save it to the desktop. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Go back to your website and copy the bottom half  of  the page.  Continue working on the 
same page paste the information on the worksheet and repeat steps 2-4 to convert that image 
into a JPEG.  Your picture should be as follows. 

                                    

Click to  

Desktop 

File name: Logo 

Save as click drop down 

arrow and click JPEG 

Interchange Format. 

 

             Click Save 

6. You are going to go back to your letterhead and finish creating it. 
7. On your toolbar click on the rectangle shape and draw it to the 
left from the top to the bottom.   
8. Go to Insert-Picture and insert the JPS logo.  Place the logo in-
side the rectangle as shown below. 

 
9. Insert a textbox  under the logo. 
Font-Garamond Size 11; Bold and 
type “Building Stronger Schools 
Together.” 
10. You will group those three items.  
Click on the first one hold the shift 
key down and click on the others. 
Notice two squares appear click on 
them. All three objects are combined 
as one.  
11. Insert the JPS School Closing in-
formation and place it inside the rec-
tangle.   
12. Before grouping adjustments may 
have to be done. 
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           Jackson Public Schools 
 Wildwood Avenue 

 Jackson, Michigan 49201 
                517-841-2200 

JPS 

Building Stronger Schools Together 
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 Creating a Greeting Card  
You have numerous options for creating Greeting Cards.  Select Thank You #8.  We will use a 
combination of  infusing your own creation into the pre-set templates.  To the right of  your  
selection you can decide how the layout should be along with the design type. 
 
 
 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
Click Create and notice there are four pages.  We will specialize each section adjusting font sizes, 
color and pictures.  We will also add a border from the design gallery complete and save the card. 

Greeting 

card types 

Fold type half 

or quarter fold 
 

 

 

 

 

 

 

          

Layout type 


